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1. Getting Started 
 

Video available: 

 

 

We recommend following these steps to quickly get started: 

 

1. Download and install the indicators in Metatrader 4, following these instructions 

in the guide 

 

 

1 Email received after the purchase 

https://youtu.be/IMF-47hGzOc
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2. Activate the indicators ‘AT-VSA’, ‘AT-Congestions’ and ‘AT-Reversals’ by 

inserting the user key in the indicator inputs (first setting) 

 

 

3. Open the charts (example: EURUSD H1, EURUSD M15, USDCHF D1) you wish to 

trade in 

 

4. Open the navigator 

 

 



8                                                          Copyright © 2017 www.AnalyticalTrader.com 
 

5. Run ‘AT- START HERE’ to apply the default template to all the loaded charts. 

Alerts will now automatically show for any opened chart. 

 

 

 

6. Check the trading strategy in this guide as you get alerts 

 

 

 

 

 

 

 

 

 

 



9                                                          Copyright © 2017 www.AnalyticalTrader.com 
 

2. Guide Overview 
 

This is a user guide for Analytical Trader’s VSA users that aims to: 

 

1. Explain the purpose and technical functionalities of each indicator in the 

package: 

a. The meaning of signals, colors, and settings 

b. What each indicator tells us, and how each one of them is integrated in 

the trading system 

 

2. Give an overview of VSA methodology in a clear way: 

a. Explain the logic behind this method 

b. Accumulation/distribution 

c. How to use the indicators to read the market 

 

3. Explain the VSA Trading System: 

a. When to enter 

b. How to manage trades 

c. Avoiding pitfalls 

d. Signals frequency, winrate, statistics 

 

2.1 DEMO OR FULL VERSION? 
 

This guide was thought for both the DEMO and FULL users. In the DEMO version, you 

can trade by following the guidelines of each setup. In the FULL version, the Alert 

System will instead look for the setups automatically. 
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2.2 SUGGESTIONS TO APPROACHING THE GUIDE 
  

We are aware that the guide can be extensive, but that’s because it includes every 

minor technical detail. We recommend trying out the indicators first, in a few charts, 

and consult the guide to progressively understand the different indicators and alerts.  

 

2.3 WHAT TO EXPECT FROM THIS SYSTEM? 
 

VSA (volume spread analysis) looks for entirely different patterns than most trading 

systems, and that’s why it can provide leading indications of market reversals, and 

hence, timely alerts. It’s a comprehensive system based on sound, tested rules, which 

aim for a profitability in the long-term, covering both trade setups and how to 

manage/close positions, with favorable risk to rewards and winning rates.    
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3. Brief VSA Methodology 
 

VSA (Volume Spread Analysis) is a proven set of techniques of analyzing financial 

markets. First developed by Richard D. Wyckoff, one of the most successful Wall Street 

traders of all time, in the 1900s, and perfected by Tom Williams, during the time he was 

a syndicate trader for 15 years based in London in the 1960s-1970s. Other very 

successful Wall Street traders like William O’Neill use it as well. It’s based on supply and 

demand, which governs any market, and not anything else: no technical indicators, no 

price patterns, just pure price and volume action. 

 

Any business where there is money to be made has professionals: Art has professional 

traders, poker has professional players, betting has professional betters, and financial 

markets have professional traders. Being successful in the markets is all about 

following the footsteps of the ‘sharks’ of this game: market operators, pit traders, 

market-makers, syndicate traders and top professional traders. The purpose of VSA 

analysis is to show you what the professionals, also named ‘smart money’, are doing, to 

profit with that knowledge. 
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1 Distribution before major turn in Gold. These patterns show in every timeframe across 
different markets 

 

3.1 HOW DO PROFESSIONAL TRADERS REALLY TRADE? 

Consider yourself in the seat of a professional trader, with a large capital pool: you are 
long on a given stock, in a very large position (the same logic applies to currencies and 
commodities, stocks are used in the example to simplify). Now, because the analysis you 
did tells you should close positions, how will you do it? If you sell all the shares you have 
in a single order, that will cause panic in the market and the prices will depress, rapidly 
going against you.  

 

A smarter way of doing it is to sell, say, 5% of all the shares you own at a given period of 
time, and repeat it until you sold everything. That way you won’t cause a panic in the 
market, and you have more chances of selling the shares at a more interesting price! 
This is called distribution, also named institutional selling, whereas the reverse (timely 
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buying) is called accumulation. And when is the best time to do this? Well, since you 
want to sell the most amounts of shares in the least amount of time, without putting 
the price against you, the best time to do it is when the public is buying, since they will 
absorb all the supply. Note that in forex accumulation and distribution happen at a 
much faster pace, since these are very liquid markets. Nonetheless, VSA applies just as 
well and you can see when exactly when it happens. 

 
One really fast way to check this: open up any random chart with volume, zoom out, 
and check the volumes (real or tick volume for forex, both work) on the bottoms and 
tops. You’ll notice the volumes are unusually high at these turns: and there you have 
your accumulation and distribution. 

  

3.2 SO HOW DO WE DETECT WHAT THE SMART MONEY IS DOING, AND HOW CAN 

WE PROFIT FROM IT? 

Well one thing about professional traders, is that they usually have a lot of money to 
invest, otherwise they wouldn’t be making a living out of the markets. Sure there are 
not-so-rich starting professional traders, but the mature ones are and those are the 
ones you want to be keeping the track of anyway – so following volume is essential to 
see their activity! High volume (high institutional activity) and low volume (low 
institutional activity) are very important signals which can tell you what the big boys are 
doing. You can also detect their activity in the spread (High – Low) and closing of the 
bars. You won’t need to do any classical technical analysis or fundamental analysis, 
since that has already been done: you just have to follow their footsteps! 
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4. Installation Guide 
 

1. In Metatrader 4, go to File -> Open Data Folder -> And copy the data folder’s 

location. 

 

2. Inside the downloaded ZIP file, open the “AT-VSASystem-Setup.exe” file. 

 

3. Follow through the Installation Wizard, and when it asks the folder where to 

install to, paste the data folder’s location copied above 

 

4. Continue through Installation Wizard 

 

5. Return to your Metatrader 4. The indicators should appear under Indicators after 

refreshing 

 

Setup Video available: Click here to watch in Youtube 

 

 

 
 

 

https://www.youtube.com/watch?v=18Tv0utQ4OE
https://www.youtube.com/watch?v=18Tv0utQ4OE
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4.1 TROUBLESHOOTING INSTALLATION 
 

If you couldn’t get the indicators to run, kindly check our troubleshooting page for the 

most common issues, or contact us directly through the website. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.analyticaltrader.com/demo-setup-troubleshoot/
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5. VSA Indicator 
 

The VSA indicator (‘AT-VSA’) has 2 main functions: 

1. Identify supply/demand signs in the chart 

2. Identify the market background, based on supply/demand and trend 

 

 

2 VSA Indicator 

 

Video available: Click here to watch in Youtube 

 

https://www.youtube.com/watch?v=hJ3F-VjoSNg
https://www.youtube.com/watch?v=hJ3F-VjoSNg
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5.1 SUPPLY/DEMAND SIGNS 
 

VSA identifies various supply/demand signs based on the candles price and volume 

formation. These are candles that show a high institutional traders activity, and so, they 

are essential to decide when to trade.  

 

Multi-timeframe 
 

The VSA signals are taken from 3 different timeframes: 

1. Current timeframe – drawn as a dot • 

2. Above timeframe – drawn as a circle ⚪ 

3. 2-Above timeframe – drawn as a square  

 

https://www.youtube.com/watch?v=hJ3F-VjoSNg
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The above timeframe’s signals also take the current timeframe into account, to keep 

them as reliable as possible in signaling a market reversal. This means that they may not 

show up in the same places as in the above timeframe chart. 

 

5.2 COLORS 
 

Each signal’s color has a different meaning: 

 

STRONG             WEAK 

                                    Major Demand                           Major Supply 

                                    Demand                                       Supply 

                                    Minor Demand                           Minor Supply 

                                    No Supply                                    No Demand 

 

 Strong signals always appear below candles, while weak signals always appear 

above candles. 

 Current timeframe, and multi-timeframe signals use the same color scheme 

 

How to use? 
 

The signs should not be traded directly. They should be used with the background and 

short-term trend as explained ahead.  

 

 

 

 

v

v
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5.3 MARKET BACKGROUND 
 

The market background analyzes two factors to determine whether the market is strong, 

weak, or neutral: 

1. Supply/demand signs present in the chart 

2. Market trend 

 

The background period, set as 200 as default, sets the number of bars to look back, for 

both of these factors. This is an appropriate period for this trading system. 

 

Multi-timeframe 
 

The background is shown in multiple timeframes in the top-right corner of the chart: 

 

 

2 Multi-timeframe Background 

 

 

Colors and meaning 
  

              Very strong                         Very weak                                 Neutral 

              Strong                                  Weak 
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 A very strong background gives more confidence in a long trade than just a strong 

or neutral background. This is measured by the trend and strength of recent 

demand signs 

 

How to use? 
 

The background should be used as a filter. Generally: 

1. When the background is very strong/strong, look for long positions 

2. When the background is very weak/weak, look for short positions 

3. When the background is neutral, stay on the sidelines 

4. If the upper timeframe’s background is in line with the current timeframe’s 

background, it’s more likely to be a strong market 

5. In the full version, the alert system takes the background into account before 

sending out an alert.  

 

5.4 ALERTS 
 

VSA indicator implements standalone alerts that trigger when there is a VSA signal. It 

has the option to filter these alerts with the background. Additionally it has the options: 

 Send alert by e-mail 

 Send alert by push notification 

 

To activate these alerts, set the below settings to ‘Yes’: 
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3 Activating Alerts in VSA 

 

 In the full version, these alerts are deactivated as default, since ‘Alert System’ 

indicator includes this type of alert, with suggested stop-loss and take-profit 

levels. 

 

5.5 SETTINGS 
 

The settings allow to change the look-back period of the indicator, change the 

background period, to set the alerts, and to customize colors. You can find their use 

below: 

 

General 
 

Product Registration Key – Insert your user key 

Called by Expert Advisor? – If calling VSA from an expert/indicator, choose the option 

‘Yes’. That will prevent conflicts with drawn objects (background). Leave ‘No’ when 

using the indicator normally in the chart. 
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Signals Module 
History – Number of bars to be drawn in the chart 

Activate minor signals – Set to 'Yes' to draw minor VSA signals 

Show Multitimeframe Signals – Set to 'Yes' to show MTF VSA signals 

 

Background Module 
Show Background – Set to 'Yes' to show the background in the chart 

Show Multitimeframe Background – Set to 'Yes' to show the background in every 

timeframe 

Top & Left – Choose the background corner with these settings 

Background Period – Number of bars to be used in the background calculation 

COLORS – In the below settings you can choose the colors of each background type, 

along with the font color 

 

Alerts Module 
Activate Signals alerts – When set to 'Yes', VSA will alert of any VSA signal that appears 

Filter Signal alerts using background – When set to 'Yes', strong signals will only be 

alerted when the background is strong, and vice-versa for weak signals. When the 

background is neutral, it won’t alert of any signal 

Send alert by e-mail – Send alerts by email 

Send push notification – Send alerts by push notification 

Write alert in chart – Each alert will be written in the top-left corner of the chart 

Alert Major Supply/Demand signals – Set or unset the alerts for these signals 

Alert Supply/Demand signals – Set or unset the alerts for these signals 

Alert One Timeframe Above Signals – Set or unset the alerts for these signals 

Alert Two Timeframe Above Signals – Set or unset the alerts for these signals 

Alert Minor Signals – Set or unset the alerts for these signals 

 



23                                                          Copyright © 2017 www.AnalyticalTrader.com 
 

Other settings 
Set to 'Yes' to set GMT offset – If setting GMT offset manually, set this setting to 

'Yes'. It’s not necessary to set GMT offset manually if no warning message appears on 

the chart. The indicator automatically detects it and saves it for further use. 

Set your broker’s GMT offset – If setting GMT offset manually, set your broker’s GMT 

offset here 

Check for updates automatically – If set to 'Yes', the indicator will automatically check 

and notify when there is a new update 

Reset data file – If set to 'Yes', the data file with the signals will be deleted. Set to 'Yes' 

only if suggested by the support 

Check for too many loaded bars (performance) – If set to ‘Yes’, VSA will show a warning 

when too many loaded bars are hindering performance (memory usage) 

Using Renko/special chart – Set to ‘Yes’ in case you are using VSA on a renko or other 

type of chart. VSA is supported on historical (non-updating) Renko charts. 
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6. Advanced Volumes / Color Bars  
 

Advanced Volumes (‘AT-AdvancedVolumes’) is an indicator that plots the volumes 

histogram, and categorizes them into different types. It plots an average for the 

London/New York and Tokyo’s sessions to use as benchmark. 

 

 

4 Advanced Volumes Indicator 

 

Color Bars (‘AT-ColorBars’) paints the chart’s candles/bars to highlight these same 

volumes, for an easier visualization. 

 

 

5 Color Bars Indicator 

 

Both indicators highlight the same bars – Color Bars just doesn’t draw the ‘regular 

volumes’ bars as default in the price chart, hence the missing blue bars in the price chart. 
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6.1 TYPES OF VOLUME AND THEIR MEANING 
 

The volume type bars are more context-dependent than the VSA signs, and that’s the 

major difference between VSA and Advanced Volumes/Color Bars. A test or low volume 

bar can mean different things, depending on where they appear. This indicator can 

show supply/demand signs when VSA doesn’t, and vice-versa, and so, it’s good to keep 

track of both. 

 

               Churn 

 

A churn is a narrow range bar with high volume.  

 

Bars like this often denote supply as the smart money 

prevents the price from moving further by dumping sell 

orders into the market – that’s why it has a narrow range and 

high volume (vice-versa for demand patterns, after a market 

downtrend).  

 

Due to this, churns often show up before market corrections and significant trend 

changes. 

 These are more significant if the market is making new highs or lows, so that the 

high volume doesn’t come from locked-in traders waiting to get out at a profit or 

break-even in a former support/resistance. 

 

               Upthrust/Downthrust 

 

Upthrusts are bars which, at the right place, can be a confirmation of weakness in the 

market (vice-versa for downthrusts, in a market bottom).  

They’re maneuvers to get stop-losses and stop orders, as well as to test the 

supply/demand in a given price level. They have more meaning when they appear: 

o 

o 
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 Near a support/resistance 

 Near a price area where there was previous supply/demand 

 On new highs/lows in the market 

 

              High Volume 

 

These bars signal that the volume is significantly higher than the session’s average.  

 If the market is rising and there is high volume, with no further price progress, it 

shows supply. Vice-versa for falling markets 

 A wide range bar, closing on the highs, with high volume, shows demand 

 

These bars are important to prevent risky trades, and to close trades, as we will see 

ahead. 

 

              Low Volume 

 

Low volume bars show a temporary lack of demand or supply in the market. These are 

often good long (short) entry spots after significant demand (supply) has been seen. 

When breaking out a support/resistance, it’s important that the volumes are average to 

high, and so, these bars in those areas signal a likely reversal.  
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6 Low volume bars on new highs 

 

 

              Supply Test 

 

A ‘supply test’ is a bar that tests the market for supply. This happens by taking the 

market to lower prices, usually to a demand/high volume area.  

 

Low volume and a quick reaction to the upside means that there is likely no supply left, 

otherwise the volume would have fired when prices were getting to a lower point (by 

long traders closing in their positions, or traders shorting on a breakout).  

 

A supply test happens near a significant level: 

1. Previous demand in the market (VSA demand signs) 
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2. High volume area (red bars) 

3. Support or up trendline 

 

 

7 Supply test 

 

On the other hand, when you don’t see a quick up reaction after a ‘supply test’, you can 

expect lower prices, and likely, further testing in lower prices.  
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8 No reaction after bullish test shows weakness 
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              Demand Test 

 

A ‘demand test’ is the exact opposite of ‘supply test’. It tests for demand, by taking 

prices higher. You would expect to see a quick down reaction if the market is weak, 

otherwise higher prices are to be expected. 

 

 

9 Successful Demand Test 
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6.2 HOW TO USE? 
 

Advanced Volumes/Color Bars is used to time positions closing and opening. After 

strong indications, and failing to enter when the alert appears, you could still enter in a: 

 Low volume down bar 

 Down churn 

 ‘Downthrust’ 

 Supply test with its high broken in the next 3 bars 

 

Closing the position 
 

You should exit after 2 or more weak signals, when holding a long position. These could 

be for instance, a churn and a low volume up bar, or an upthrust and a churn. As an 

exception, a ‘failed test’ (failure to rally between 4-7 bars) is a sufficient reason to close 

a trade.  

VSA and supports/resistances also play a role when closing a trade. This is discussed 

ahead in the trading section. 
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6.3 SETTINGS 
 

In Advanced Volumes settings, you can set alerts for each of these bars, change moving 

average period, and customize the colors. ‘Color Bars’ settings are similar. 

 

General settings 
Product Registration Key – Enter your user key here 

Set to 'Yes' to set GMT Offset – Set to 'Yes' to set GMT offset manually. It’s not 

necessary to set GMT offset manually if no warning message appears on the chart. The 

indicator automatically detects it and saves it for further use. 

Set your broker’s GMT Offset – If the above setting is 'Yes', the value inserted here 

should be your broker’s offset. It’s not necessary unless there is an error retrieving 

automatically. 

History – Number of bars to calculate the volumes for 

Moving Average Period – Period of the volumes moving average. For the H4 timeframe 

and above, it should be set to 20, due to a higher variability in volumes on high 

timeframes. Otherwise, 50 is a good value. 

Check for updates automatically – Set to 'Yes' for the indicator to check and notify of 

updates automatically 

  

Alerts Module 
Low Volume Alert – Set to 'Yes' to alert of low volume bars 

High Volume Alert – Set to 'Yes' to alert of high volume bars 

Churn Alert – Set to 'Yes' to alert of churn bars 

Test Alert – Set to 'Yes' to alert of test bars 

Thrust Alert – Set to 'Yes' to alert of thrust bars 

Email Alerts – Set to 'Yes' to email alerts. In Metatrader, go to Tools > Options > Email 

tab to configure it 
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Push Notification Alerts – Set to 'Yes' to send alerts to your Smartphone. In Metatrader, 

go to Tools > Options > Notifications tab to configure it 
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7. Alert System 
 

Alert System (‘AT-AlertSystem’) is a multi-functions indicator that draws 

supports/resistances, dynamic trend, and alerts of various VSA setups. 

 

 

 

 

 

10 Alert example in Alert System. Shows suggested SL, TP and an aiding text. 

 

 

 To learn in detail what each alert means, kindly check the section ‘Trading with 

VSA Package’.  

Alert System is limited to the FULL version (unavailable on demo). 
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7.1 ALERTS 
 

Alert System’s alerts look for various factors, such as supply/demand, background, 

short-term trend and price action. They greatly ease the trader’s work by scanning for 

the alerts automatically, while maintaining usefulness by showing alerts with 

profitability and a good frequency. They can be optionally sent by email and/or push 

notification for convenience. 

 

The indicator alerts of different trading setups. They are: 

1. Supply/Demand + Background Alert 

2. Dynamic Trend Alert 

3. Support/Resistance Nearby Alert 

4. Support/Resistance Breakout Alert 

5. Congestion Zone Nearby Alert 

6. Congestion Breakout Alert 

 

Each type of alert has an optimized stop-loss and take-profit, and an explanatory 

description on the most important factors to look out for.  

 

Alerts are sent to your Metatrader platform, by email and by push notification, 

optionally. 
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Activating Alerts 
The alerts are scanned while the indicator is inserted in a given chart. They work for 

every timeframe above (and including) 5 minutes, though an adaptation to higher 

timeframes will be discussed ahead in the guide.  

 

 You should insert the Alert System indicator in the pairs and timeframes you wish 

to trade 

 

The alerts are activated automatically, and they will remain active whether there are 

other indicators in the chart or not.  

 

Stop-loss, TP1 and TP2 
Each alert shows a stop-loss, TP1 and TP2 points: 

 

Take-profit 1 (TP1) – When the price reaches this level, you should move your stop-loss 

to break-even, or to close half the trade for some alerts. 

Take-profit 2 (TP2) – You should set the take-profit in this level when you open the 

trade. 

Stop-loss (SL) – You should set the stop-loss here in most cases. The only exception is 

when there is a support nearby, in which case you should set the stop-loss below it 

instead (vice-versa for resistances).  

 

 

 

 

 

 

 

Refer to the ‘Trading with VSA System’ section to learn more about each alert. 
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Locking Alert 
Once you receive an alert on your platform, you’ll be able to lock it. Locking an alert 

assures: 

1. That it won’t be replaced by a new alert 

2. You will receive the exit warnings accordingly 

 

 

 

 

 

To lock an alert, simply click ‘L’ button in the top-right corner of your chart: 

 

 

 

 

 

 

TIP: When tracking or trading on the last alert, make sure to lock it! 
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Once locked, the button will show up as red and new alerts will be disabled (until the 

current alert is unlocked again): 

 

 

 

 

7.2 EXIT WARNINGS 
 

Exit warnings show up when there is a potential exit signal (i.e. a signal to close the 

trade).  They are: 

1. Wide bar + high volume Warning 

2. Time-based Warning 

3. VSA signal Warning 

4. SR Breakout Warning 

5. Weak Action Warning 

 

Below you can read a brief description of each, and how it shows in the chart. For more 

information on how to use each warning, refer to ‘Trading with VSA System’ section. 
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Symbols and Colors 
 

 
Close Long (above candles) Close Short (below candles) 

Wide bar + high volume ★ ★ 

Time-based ★ ★ 

VSA signal ★ ★ 

SR Breakout ★ ★ 

Weak Action ★ ★ 

 
On the chart, by hovering the mouse over each symbol you’ll also be able to see what it 

means. 

 

 

Wide bar + high volume Warning 
 

This warning appears when there is a wide down bar, with high volume, after a long 

alert (vice-versa for short alerts). It’s a sign of supply that many times precedes a 

downturn. 

 

Time-based Warning 
 

Warning that shows when 20 bars have passed since the alert, without hitting the target. 

If the price isn’t moving in your direction, and it’s not even close to it, it’s usually a good 

idea to close the trade. 

 

Note: Exit Warnings will only show up when there is an active alert (i.e. stop-loss and take-

profit weren’t yet hit) 
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VSA Signal Warning 
 

This warning shows when there is a supply VSA signal after a long alert, or vice-versa. 

 

SR Breakout Warning 
 

Support/Resistance Breakout warning is set off when an important support is broken 

(for a long alert). It’s a sign that your trade might be at risk of turning into a loser pretty 

quickly. 

 

Weak Action 
 

After a long alert, this warning shows up either when: 

1. There is a successful bearish test 

2. There is a failed bullish test 

 In any of the cases, it’s a solid sign to close your position. 

 

7.3 SUPPORTS/RESISTANCES 
 

‘Alert System’ automatically draws supports/resistances (from short-term to long-term). 

 

These are old lows/highs in the market, which are zones with significant order clusters. 

This makes it a prone area for stop-loss hunting on fake-out movements, and entices 

traders to play for the break-out or the reversal. Due to this increased liquidity, it’s 

profitable for large traders, many of whom have access to the order book, to come in. 

 

Supports/resistances are categorized in: 

 Short-term   (Dotted line) 
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 Medium-term   (Dashed line) 

 Long-term    (Solid line) 

 

 

Supports/Resistances Colors 
 

Support                                             Resistance 

 

7.4 DYNAMIC TREND 
 

This is a short-term trend indicator drawn by Alert System, that smooth out prices and 

pinpoints the trend by color. This is nothing like a simple or exponential moving average 

– Dynamic Trend has a low lag, and it’s still smooth unlike the exponential average. It’s 

used as filter to confirm strength or weakness by VSA signals and the background. 

 

The most important setting indicator is the period. It’s the amount of bars it will take for 

the calculation – a low value will mean it’ll be more sensitive, and it will signal shorter 

trends. The default period, 15, is the ideal period for this trading system, as it captures 

the ‘medium-term’ trends. 

 

Dynamic Trend Colors 
 

               Uptrend                                      Downtrend                             Trend Changing 
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11 Alert System draws Dynamic Trend and Supports/Resistances 
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7.5 SETTINGS 
 

Product Registration Key – Enter your user key here 

Called by Expert Advisor? – If calling Alert System from an expert/indicator, choose the 

option ‘Yes’. Leave ‘No’ when using the indicator normally in the chart. 

  

General Settings 
Alerts Activated – Set to 'Yes' to activate alerts 

Alert when Price reaches BE/TP Level – If 'Yes', the indicator will alert when price 

reaches to the break-even/take-profit level 

Email alert – Send alerts by email 

Push Notification alert – Send alerts to smartphone 

Text in chart on Alert – Show alerts on the chart 

Show Alert window – Show explanation window of alert 

Alert window’s corner – Corner for alert description window to appear 

Panel Font – Font style of the window’s text 

Panel Font Size – Font size of the window’s text 

 

Module VSA Signals 
Activate VSA with Background Alerts – Activates alerts of VSA Signal + Background 

Max price change in ATR’s to activate this alert – When there is a VSA signal, price 

cannot move more than this number in average true range’s in order for the alert to 

activate 

  

 

Module Dynamic Trend 
Draw Dynamic Trend – Draws dynamic trend 
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Activate Dynamic Trend Alerts – Activates dynamic trend change alerts, using 

background and other factors as filter 

Dynamic Trend Period – choose dynamic trend period to use 

Max distance from VSA signal – For the alert to activate, price must be within this 

number of average true range’s from the VSA signal’s close 

 

Module Supports/Resistances 
Draw long-term S/Rs – Choose 'Yes' to draw long-term supports/resistances 

Draw medium-term S/Rs – Choose 'Yes' to draw mid-term supports/resistances 

Draw short-term S/Rs – Choose 'Yes' to draw short-term supports/resistances 

Activate long-term S/Rs Nearby Alerts – If 'Yes', it will alert of nearby 

supports/resistances, using background and other factors as filter 

Max distance from long-term S/R to activate alert (ATR’s) – Maximum distance in 

average true range’s from the S/R for the alert to be activated 

Activate long-term S/Rs Breakout Alerts – If 'Yes', it will alert of supports/resistances 

breakouts, using background and other factors as filter 

Max distance from long-term S/R to activate breakout alert (ATR’s) – Maximum 

distance in average true range’s from the S/R for the alert to be activated 

 

Module Congestions 
Activate Congestions Nearby Alerts – Choose ‘Yes’ to activate congestions nearby alerts 

Max distance from CZ to activate alert (ATR’s) – Maximum distance from price to 

congestion zone for the alert to be activated 

Max distance for stop-order (ATR’s) - Maximum distance from stop-order price to 

congestion zone for the alert to be activated 

Activate Congestions Breakout Alerts – Choose ‘Yes’ to activate congestions breakout 

alerts 

Max distance from CZ to activate breakout alert (ATR’s) - Maximum distance from price 

to congestion zone for the alert to be activated 
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Module Exit Warnings 
Activate ‘Wide up/Down bars’ Exit Warning – Choose ‘Yes’ to activate this exit warning 

(more info on exit warnings section) 

Activate ‘Time-based’ Exit Warning – Choose ‘Yes’ to activate this exit warning (more 

info on exit warnings section) 

Activate ‘VSA’ Exit Warning – Choose ‘Yes’ to activate this exit warning (more info on 

exit warnings section) 

Activate ‘SR Breakout’ Exit Warning – Choose ‘Yes’ to activate this exit warning (more 

info on exit warnings section) 

Activate ‘Weak Action’ Exit Warning – Choose ‘Yes’ to activate this exit warning (more 

info on exit warnings section) 

 

 

Module Colors and Styles 
Bullish alerts description font color – Color for bullish alert 

Bearish alerts description font color – Color for bearish alert 

Resistance line color – Color for drawn resistances 

Support line color – Color for drawn supports 

S/R Lines Styles and colors – Choose your preferred style and color for each 

support/resistance line 

 

Note: The colors for the dynamic trend and SL/BE/TP dots are set in the ‘Colors’ tab. 

 

Others 
Set to 'Yes' to set GMT offset – If setting GMT offset manually, set this setting to 

'Yes'. It’s not necessary to set GMT offset manually if no warning message appears on 

the chart. The indicator automatically detects it and saves it for further use. 
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Set your broker’s GMT offset – If setting GMT offset manually, set your broker’s GMT 

offset here 

Check for updates automatically – Automatically checks and notifies of new updates, if 

set to 'Yes' 

Check for too many loaded bars (performance) – If set to ‘Yes’, it will alert if the 

number of loaded bars are hindering performance (memory usage) 
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8. Available Templates 
 

The VSA system brings various templates tailored for specific needs. Below you can find 

what each one of them includes, and their uses. Note that all the templates include both 

light and dark variations as color schemes. 

  

To find and insert templates in Metatrader, go to Charts > Template, or search for the 

templates icon in the top toolbar. 

 

8.1 ‘AT CONGESTIONS ONLY’ 
 

It includes AT-Congestions indicator only, with the default settings. Use it if you want to 

test anything specific having to do with this indicator. 

 

8.2 ‘AT ALERTS’ 
 

This is the standard template to look for setups. It includes: 

 Alert System (limited to the full version) 

 VSA 

 Color Bars 

 Spreads 

 Congestions 

 Advanced Volumes 

 News 

You will want to use this one when looking for opportunities in the market.  
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This template should be used either when: 

1. There was an alert that you have missed, and you are now looking for another 

entry opportunity 

2. Managing an open trade 

 

It includes: 

 VSA 

 Congestions (just zones) 

 Reversals 

 Color Bars 

 Advanced Volumes 

 Spreads 

 Supports/Resistances 

 Dynamic Trend 

 News 

 

8.3 ‘AT REVERSALS ONLY’ 
 

It includes AT-Reversals indicator with a Dynamic Trend of period 250. Use it if you want 

to test anything specific having to do with this system (check Reversals manual for more 

information). 

 

 

 

 

 

8.5 ‘AT VSA NO ALERTS’ 
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This template doesn’t include Alert System, in case you just want to check for 

supply/demand signs or congestion zones. It includes: 

 VSA 

 Color Bars 

 Advanced Volumes 

 Congestions 

 Spreads 

 News 
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9. Trading with VSA System 
 

The alerts from the ‘Alert System’ indicator analyze the most important factors in order 

to trade the various strategies (setups). These setups can also be traded without the 

Alert System (in the demo), by following the instructions below. 

 

Here’s how a typical alert looks: 

 

3 A typical alert in Alert System 

 

Dynamic Trend – this is a short-term trend indicator to filter some signals 

Alert explanatory window 

Alert explanatory window: When maximized, shows the most important factors to look 

for, and how the trade should be placed (market or stop order), for the given alert 
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Resistance – Alert System draws supports/resistances. This is a mid-term resistance 

Alert are active – When there is a ‘smiley face’, the alerts are active. If the user 

deactivates them, it will appear as a ‘sad face’. 

Stop-loss – this is where the stop-loss should be placed 

Execution price – it’s where the trade should be opened. Some alerts use market orders, 

while others use stop orders. Check the explanatory window for info. 

Move to break-even – When the price reaches this point, you should move the stop-loss 

to break-even (an alert is set off when price reaches it). 

Take-profit – You should place the take-profit at this price 

 

Apart from the alerts, there are some things to look out for in each strategy in order to 

be profitable, which we explain below. The pre-requisites apply to every alert, so make 

sure to understand those first before reading on the specifics of each alerts. 

 

9.1 ACCUMULATION/DISTRIBUTION (PRE-REQUISITE 1) 
 

For every type of alert, the most important is to check the chart for what it’s called 

accumulation/distribution.  

 

Simply put, accumulation is the presence of multiple demand signals in the same “price 

area”. It shows that professionals are buying heavily, which usually can’t be said when 

there is just a single demand signal. Vice-versa for distribution.  

 

 

 

 

 

The basic rule is: 
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 If there is a long alert, make sure there is no distribution. 

 If there is a short alert, make sure there is no accumulation. 

 

Identifying accumulation 
 

So, how do we go about identifying accumulation? We should check for three main 

signs: 

 

1. BELOW current prices, there are 3+ demand signals, and at least 1 

‘demand’/’major demand’ 

a. Or 1 major demand signal + price reversal with 2x or more the avg. volume 

2. The demand signals are within 3 ATR’s from each other 

3. Sideways or slight uptrend after the last demand signal 

 

A little digression on what ATR stands for: ATR stands for ‘average true range’ and it 

measures the candles average range. We refer to ATR’s since speaking in pips isn’t 

appropriate when referring to different symbols and timeframes – a 10 pips distance 

between 2 different closing prices is considered to be very near in a daily timeframe, 

whereas in 1 minute timeframe it can be considered as far, due to the scale factor. 

Likewise for symbols (some have much higher average pips range than others). By using 

ATR, we are correcting for this scale factor. 

 

The ATR, or average range, can be checked in: 

1. A Metatrader included indicator (ATR), with a recommended period of 100 bars. 

2. The included indicator ‘AT-Spreads’ 
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4 Average true range in 'AT-Spreads' 

 

 

Now let’s see some accumulation and distribution examples: 

 

 

5 Accumulation in EUR/USD Daily 
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6 Accumulation in USD/CAD M30 

 

 

7 Distribution in GBPUSD Hourly 
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8 Non-distribution example in USD/JPY M5. Usual near previous resistances (red lines) 

 

Concluding, when looking for a long position, make sure there aren’t multiple supply 

signals above current prices, with a subsequent sideways or downtrend market.  

 

9.2 SHORT-TERM TREND (PRE-REQUISITE 2) 
 

When having received a long alert, you should check if the market hasn’t been making 

lower highs OR lower lows. Such would signal that the market isn’t as strong as it could 

first appear, and that going long should be avoided. 
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Examples: 

 

 

9 Lower lows before long alert 
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10 Higher highs before short alert 
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9.3 ‘SUPPLY/DEMAND SIGNAL + BACKGROUND’ ALERT 
 

This alert is activated when: 

1. The background is strong 

2. There is a minor demand/demand/major demand VSA signal 

3. There isn’t nearby weakness 

 

Use a Long stop order on the purple dot. 

Alert expires after 3 bars. 

 

On Blue Dot: When it reaches the blue dot, move stop-loss to break-even 
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How to trade with VSA + Background Alert 
 

1. This long trade fits all the conditions. This alert is VALID. 

 

11 VSA + Background Long alert in EUR/AUD H1 
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2. This short trade fits all the conditions. This alert is VALID. 

 

12 VSA + Background Short alert in USD/JPY Daily 
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3. Make sure the price isn’t on new lows for a SHORT position. Often the price won’t 

get to the target when this happens. This alert is INVALID 

 

 

13 Price is on new lows. Avoid taking the short trade 
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4. If the alert was on a wide range up bar, wait for a slight correction to go in. This alert 

is VALID. 

 

In the picture below, we can see: 

1. The alert was activated after a wide range down bar. We can wait for a 

low volume up bar to short at a better price 

2. There was a low volume up bar. Short (market order) on the close 

 

 

14 VSA + Background Short alert - shorting in a low volume up bar after the alert 
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5. If price hits stop-loss point (red dot) before execution point (purple dot), the alert is 

INVALID. 

 

 

15 Price hit stop-loss before execution price. Alert INVALIDATED 
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9.4 ‘DYNAMIC TREND’ ALERT 
 

This alert is activated when: 

1. The background is strong 

2. There is one or more minor demand/demand/major demand VSA signals 

3. The dynamic trend turned from downtrend to uptrend 

4. There isn’t nearby weakness 

 

Use a Long market order. 

 

On Blue Dot: When it reaches the blue dot, close half the trade 

 

 

How to trade with Dynamic Trend Alert 
 

In this alert, you should close half the trade when reaching the blue dot, instead of 

moving the stop-loss to break-even. This is because usually the market may shift 

suddenly after this alert, and so the stop-loss shouldn’t be moved at all. 
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1. All the conditions were met for this trade. In the dynamic trend alert, the blue dot 

should be used to close ½ the trade. This alert is VALID. 

 

16 Dynamic Trend Long Alert - notice how the blue dot was hit, and after a reversal, 
market continued rallying 
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2. All the conditions were met for this short trade. This alert is VALID. 

 

17 Dynamic Trend Short Alert in GBP/USD H4 
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3. Make sure the price isn’t on new highs for a LONG position; nor new lows for SHORT 

position. This alert is INVALID. 

 

 

18 Dynamic Trend Long Alert - AVOID going long when the alert is near new highs 
in the market such as in this picture 
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4. Like in any of the other alerts, avoid taking a SHORT when there is ACCUMULATION 

nearby (vice-versa for long positions). This alert is INVALID. 

 

 

19 Dynamic Trend Short Alert - AVOID taking a short with ACCUMULATION nearby 
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9.5 ‘SUPPORT/RESISTANCE NEARBY’ ALERT 
 

This alert is activated when: 

1. There is a medium-term or long-term support just below current price 

2. Market is showing strength in the volumes 

3. The background for specific periods (not limited to the default 200) is strong 

 

Use a Long stop order on the purple dot. 

Alert expires after 5 bars. 

 

On Blue Dot: When it reaches the blue dot, close ½ the trade. 

 

How to trade with Support/Resistance Nearby Alert 
 

Like in the Dynamic Trend alert, in this alert, you should close half the trade when 

reaching the blue dot, instead of moving the stop-loss to break-even. The price will 

sometimes oscillate near the support, and so the stop-loss should be kept below it. 
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1. All the conditions were met for this long trade. This alert is VALID. 

 

20 Support Nearby Long Alert in EUR/USD M15 
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2. All the conditions were met for this short trade. This alert is VALID. 

 

21 Resistance Nearby Short Alert in AUD/USD H1 
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3. If the price is making new lows when the alert is activated, avoid taking the trade. 

This alert is INVALID. 

 

22 Support Nearby Alert - Price making new lows, avoid taking a long trade 
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4. Expect the support being shaken-out. The stop-loss gives some margin to allow that 

to happen. This alert is VALID. 

 

 

23 Support Nearby Alert - support being shaken-out 
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5. Low volume down bars NEAR the support provide another entry point. This alert is 

VALID. 

 

24 Support Nearby Long Alert - Low volume down bar provides an entry point 
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9.6 ‘SUPPORT/RESISTANCE BREAKOUT’ ALERT 
 

This alert is activated when: 

1. There is a broken resistance (close above previous resistance) 

2. The background is strong 

3. Market is showing strength on the volumes, on the breakout and before the 

breakout 

 

Use a Long market order. 

 

On Blue Dot: When it reaches the blue dot, move stop-loss to break-even 

 

The alert can still be active even after the resistance is broken, if the prices are still 

nearby. Thus, it’s usual to see this alert being set off many times after a breakout, and 

all of them provide valid entries. 
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How to trade with ‘Support/Resistance Breakout’ Alert 
 

1. Long alert after the breakout. The alert can be activated both on the breakout or 

afterwards, as long as prices keep close to the resistance. This alert is VALID. 

 

25 SR Breakout Long Alert – the alert can appear after the breakout (1) 
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2. Prices approach the resistance on wide ranges and high volumes (red bars). This alert 

is VALID. 

 

26 Price approaching resistance on a wide range, high volume bar is a bullish indication 
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3. There is a Demand/Major Demand signal OR 2 minor demand signals, in the last 

market low, before the breakout. This alert is VALID. 

 

27 Major Demand signal before the breakout shows strength (1) 
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4. If there was no strength before the breakout, don’t take the alert. This alert is 

INVALID. 

 

28 (1) Weakness before the breakout (supply signals). (2) low volume on the 1st 
breakout (more weakness) 
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9.7 ‘CONGESTIONS NEARBY’ ALERT 
 

This alert is activated when: 

1. There is a congestion zone just below current price 

2. Market is showing recent demand 

 

Use a Long stop order on the purple dot. 

Alert expires after 3 bars. 

 

On Blue Dot: When it reaches the blue dot, close ½ the trade. 

 

How to trade with ‘Congestions Nearby’ Alert 
 

With this alert, you should close half the trade when reaching the blue dot. The price 

will sometimes oscillate near the support, and so the stop-loss should be kept below it. 
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1. Two VALID ‘Congestion Nearby’ alerts. Use long stop orders on the purple dot. 

 

 

2. There were no VSA supply signals nearby before any of the alerts. These alerts are 

INVALID. 
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9.8 ‘CONGESTIONS BREAKOUT’ ALERT 
 

This alert is activated when: 

1. There is a broken congestion zone (close above previous resistance) 

2. The background is strong 

3. Market is showing strength on the volumes, on the breakout and before the 

breakout 

 

Use a Long market order. 

 

On Blue Dot: When it reaches the blue dot, move the stop-loss to break-even. 

 

How to trade with ‘Congestions Breakout’ Alert 
 

1. Use a market order to enter the trade. These short alerts were VALID. 
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2. Look-out for low volumes near the breakout. These alerts are INVALID. 

 

 

3. There was a steep uptrend (very wide bar) on the breakout. Be alert for close signals 

for an early exit. The alert is VALID.  
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4. There was another congestion zone just below the alert. Avoid taking any alert when 

this happens. The alert is INVALID. 

 

 

 

9.9 OTHER SIGNS TO LOOK OUT FOR 
 

Other signs that you should NOT take a trade: 

 

 There was a very high volume bar (> 2x average volume) nearby 

 

 If taking a long, don’t take the trade too far from the closest short-term support 

(closest low) 

 

 Avoid taking a long trade if there is a long-term resistance below the take-profit 

point. 

 

 Avoid taking a trade if there is an important news coming 
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 Trade in a timeframe with a spread < 25% average range (use ‘Spreads’ indicator) 

 

 Careful taking a long trade if prices are making new highs already (an exception is, 

of course, the break-out alerts) 
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9.10 CLOSING THE TRADE 
 

The market conditions can change very quickly, and one should be able to react quickly 

when they do. Even before reaching the take-profit or stop-loss, there are some signs 

that should make you consider closing the trade: 

 

1. A wide down bar, on high volume, can be an early warning to close the trade. 
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2. If the price isn’t moving towards the target, and 20+ bars have passed, it’s a sign to 

close the trade. 
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3. When a support is broken after a LONG alert, it’s usually a good sign to close the 

trade earlier. 

 

 

4. Strong VSA signals often provide an early warning of a reversal. 
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5. ‘Strong action’ after a short alert is not the most common warning, but it’s a very 

powerful one that tells you should close the trade rapidly. 

 

 

6. Important news. CLOSE position 5 minutes before the release. 
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9.11 STATISTICS ON THE ALERTS 
 

As of VSA version 4.72,  

 The winrate for the alerts is in average between 65%-70%. ‘VSA Signal + 

Background’ has the lowest winrate, at 62%, while the breakout has the highest 

winrate at 70%. 

 

 The average reward-to-risk is 1.4 (1.4x higher reward than risk).  

 

 In the 15 minutes timeframe, the frequency of VALID alerts is 1 alert per 2 

sessions. That means that using 6 pairs just in the 15 minutes timeframe, you 

would be expected to get 3 alerts a day. Merging other timeframes and more 

pairs, you can easily be looking at 10 valid alerts a day. 

 

 Comparatively, the difficulty to trade ‘VSA Signal + Background’ and ‘Dynamic 

Trend’ is lower than in ‘S/R Nearby’ and ‘S/R Breakout’. As difficulty, it means the 

attention and number of factors/bars that you need to check before going in. 

 

 The alerts efficacy doesn’t change significantly by pair. 

 

 In lower timeframes (hourly and below), ‘VSA Signal + Background’ and ‘Dynamic 

Trend’ tend to be more effective than the others. In higher timeframes (4 hours 

and above), the S/R alerts perform better. Nonetheless, the difference isn’t a 

major one, and they can all be used interchangeably. 

 

 For the sake of diversity, it’s recommended to use at least 3 strategies.  

 

 The results can be reproduced in the Metatrader 4 tester. The brokers tested 

were Oanda and FxPro. 
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9.12 ALERTS FAQ 
 

Below you can see the most common users’ questions and answers: 

 

1. If there is a new alert, and the older one gets erased, does it invalidate the 

previous one? 

No, an alert is never invalidated just because there was a more recent alert. The 

indicator just shows the most recent alert all the times, so you can focus on it; but if you 

were following the previous alert, you can still trade it. To find the previous values, you 

can go to View > Terminal > ‘Experts’, and the message with the alert information will be 

there. If you lock the alert, you will also prevent this from happening. 

 

2. When is an alert invalidated? 

An alert is invalidated when either: 

1. It goes against the pre-requisites and rules explained above. 

2. 3-5 bars have passed since the alert 

3. There are closing positions signs since the time of the alert. For example, if there 

are supply signs after a long alert, you shouldn’t take it anymore. 

4. For STOP orders alerts, price touching the stop-loss dot before the execution 

price dot invalidates the alert 

 

3. What win-rates and alerts frequency can I expect? 

Kindly check the section ‘Statistics on the alerts’. 

 

4. What pairs and timeframes are recommended? 

Every single one of our indicators analyze supply and demand, which can be applied to 

every pair. We also use scale-less variables which adapt to any chart. Because of this, 

you can use them in any pair and timeframe, of course, AS LONG as the spread is right – 

the ‘Spreads’ indicator will give this information. Some alerts perform better in certain 

timeframes, check ‘Statistics on the alerts’ section for more information. 
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5. Do I lose the alert if I switch timeframe? 

No, Alert System saves the dots of the most recent alert, so that you can switch 

timeframes freely. 

 

6. Are alerts sent by push notification and/or email? 

Yes, you can set it in the indicators settings so that the alerts are sent to your 

smartphone and/or email. 

 

7. How can I lock an alert, and when should I do it? 

The last alert can be locked by clicking a small button ‘L’ in the top-right corner of your 

chart. You will receive an alert saying you have locked the last alert. Locking an alert 

prevents other entry alerts from showing up, and it will make sure the closing warnings 

will always refer to that alert. 

It’s recommended to lock an alert when you opened a position, so that you can always 

see the SL/BE/TP levels, and closing warnings are activated. 

 

8. How can I unlock an alert? 

An alert can be unlocked by clicking a small button ‘L’ in the top-right corner of your 

chart. You will receive an alert saying you have unlocked the alert.  
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10. Help & Suggestions 
 

Feel free to contact us through the website (email or social networks), for any questions 

related to the guide and indicators. We realize that the guide is extensive, and that you 

may want to get help understanding the concepts. 

Looking back from 2014, when Analytical Trader was founded, we implemented most of 

the features due to clients’ feedback, and so, we are also always open to receive your 

feedback and suggestions.  


